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CATIA V5 Mechanical Design Expert - Lesson 1: Introduction Student Notes:



Introduction Introduction The goal of the CATIA V5 Expert Mechanical Designer course is to teach you how to start a complex design project from its specifications (top down approach) and complete it by reusing existing designs. This course focuses on the advanced skills and concepts that enable you to create robust designs.



Course Design Philosophy This course is designed based on a process or task-based approach to training. Rather than focus on individual features and functions, this course emphasizes the process and procedure to complete a particular task. By using case studies to illustrate these processes, you will learn the necessary commands, options, and menus within the context of completing a design task.



Target audience The target audience for this course are mechanical designers already having an experience of CATIA V5 mechanical design foundations.
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Prerequisites



5 days



Students attending this course should meet these criteria: Mechanical design experience Training on CATIA V5 Fundamentals
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About the Student Guide Using the Student Guide



This student guide is intended to be used under the guidance of a certified CATIA instructor. The examples and case studies are designed to be demonstrated by the instructor.



Exercises/Case Studies This course illustrates the process-based approach in two ways: exercises and case studies. Exercises give you the opportunity to apply and practice the material covered during the lecture and demonstration. They are designed to represent specific design and modeling situations. Extra exercises have been included in this guide to accommodate students who may want to practice more modeling. Case studies provide a context in which you use the required tools and methods, and illustrate the process flow you would use for a project.



Feedback
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Dassault Systemes gladly accepts feedback and suggestions on its courseware. Send your feedback by mail or e-mail:



• Mail: Dassault Systemes Education Department 22 Quai Galleini, 92150 Suresnes, France



Copyright DASSAULT SYSTEMES



• E-Mail: [email protected]
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Conventions used in the Student Guide The following typographic conventions are used in the student guide:
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• Bold blue text within a sentence denotes options selected from the CATIA menu bar. • Red brown text denotes the name of a tool, icon, button, or window option. • Italic text within a sentence is used to emphasize key words. • Numerical lists are used in sequential lists, such as the steps of a procedure. • Lower-case alphabetical lists are used in sequential sub-lists, such as the sub-steps in an exercise procedure. • 2b identifies areas in a picture that are associated with steps in a sequential list, such as in an exercise. • Upper-case alphabetical lists are used in non-sequential lists, such as a list of options or definitions. • Text enclosed in < > brackets represents the name of the keyboard key that must be pressed. • Text enclosed in [ ] brackets corresponds to the text that must be entered into a text field of a CATIA dialog box or prompt.
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Example page: Use the following steps to create a new document in CATIA: 1. Click Start > Mechanical Design > Part Design. 2. Create new part. a.Click File > New. b.Select Part from the New window. c. Select OK.



2b



d.Press + to save the document. e.Enter [my first document] as the document name. You can create the following profile types: A. User Defined Profiles B. Pre-Defined Profiles C. Circles A



B
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Case Study



Student Notes:
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Each lesson in this course contains a case study, which explains the skills and concepts covered in the lesson. The case study will be described at the beginning of each lesson. The student will be able to do the case study exercise once the theory for that lesson has been covered. These models help to relate the topics discussed in each lesson. It is important to remember that the topics discussed in each lesson can be used in many applications, they do not have to be used together. They are brought together to understand the use of these methods and tools. At the end of this lesson you will work on a warm up exercise that will help you to recall what you learnt in the V5 Fundamentals course.
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Design Intent



Student Notes:



Each case study contains a set of model requirements, known as the design intent. The design intent section will help you to understand why the tools you are about to learn are needed. The first case study does not contain a design intent because you are not designing anything. However, by the end of this lesson you should be able to:
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Recall the Part Design workbench and the tools you learned in the Introduction course. Recall the importance of parent child relationships. Understand the importance of organizing bodies.
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Stages in the Process



Student Notes:



Each lesson explains the material in steps, which outline procedures to create the part or an assembly in the case study. Each step contains the information you need to complete the case study and maintain its design intent. These steps do not have to be used together. They have been brought together for the case study. In each lesson try to think of other uses for all the steps. For this lesson, you will go through the following steps to complete the introductory lesson:



Copyright DASSAULT SYSTEMES



1. Review the user interface. 2. Understand the importance of parent-child relationships. 3. Understand how to organize the model.
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CATIA V5 Mechanical Design Expert - Lesson 1: Introduction Student Notes:



Review the User Interface In this section, you will review the user interface of the workbenches you have studied in the V5 Fundamentals Course. You will also be introduced to the Generative Shape Design Workbench. Use the following steps: 1. 2.



Importance of Parent/Child Relationships Organizing a Model.
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3.



Review the User Interface.
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CATIA V5 Mechanical Design Expert - Lesson 1: Introduction



CATIA Workbenches



Student Notes:



CATIA is a mechanical design software. It is a feature-based, parametric solid modeling design tool that takes advantage of the easyto-learn Windows graphical user interface. You can create fully associative 3D solid models with or without constraints while utilizing automatic or user-defined relations to capture design intent.
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In the V5 Fundamentals course, you were introduced to the Part design, Sketcher, Assembly Design and Drafting workbenches. You have also practiced working with some tools in these workbenches by performing the Exercises and Case Studies. In this course, you will learn more about the Part Design and Assembly Design workbenches. You will also learn some functionalities available in the Generative Shape Design workbench.
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Part Design Workbench



Student Notes:



The Part Design workbench lets you build solid 3D geometry. It is one of the primary CATIA workbenches. From the Part Design workbench you can access the Sketcher workbench and create 2D profiles that will become 3D model. In the V5 Fundamentals course, you have learned about the sketch-based and dress-up features. In this course you will learn about additional tools and modeling techniques such as the multi-body method.
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You will also learn how to access this workbench from the Assembly Design workbench where you can use collaborative methods such as Designing in Context and the Skeleton method.
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Assembly Design Workbench



Student Notes:



The Assembly Design workbench allows you to bring components together to create the final product. In the V5 Fundamentals course, you learned how to rigidly constrain components to build assemblies. In this course you will learn how to build flexible assemblies and analyze assemblies. You will also learn how to access the Part Design workbench from the Assembly Design workbench. This lets you build parts in the context of the assembly. Contextual design is a powerful tool to create parts in an associative manner.
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You will also learn methods of designing assemblies that will aid in concurrent engineering, such as Skeleton models and publishing elements.
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Generative Shape Design Workbench



Student Notes:



In this course you will be introduced to another workbench, the Generative Shape Design workbench. This workbench lets you create surface and wireframe geometry. The surface and wireframe geometry allows you to create more complex solid models and gives more control over the shape of a model.
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You will learn about the different methods to organize surface-based models and also how to create solid models from the surface features.
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Importance of Parent/Child Relationships



Student Notes:



In this section, you will recall what parent child relationships are and why they are important to understand when creating a model.



Use the following steps: 1.



2.



Importance of Parent/Child Relationships



Organizing a Model.
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3.



Review the User Interface.
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Design Intent



Student Notes:



Design intent is a plan to construct solid model of a part, in order to convey its visual and functional aspects. In order to use a parametric modeler like CATIA efficiently, you must consider the design intent before and during the modeling of the part. The techniques used to create the model affect how the model behaves when it is changed during its life cycle. The way a solid model is built can affect many aspects, including its flexibility to changes, its stability during the change process, and the resource requirements to compute a new result. Therefore, it is important to take the design intent into account to achieve an efficient solid model of the part. The following factors contribute to design intent: Automatic (Implicit) Relations • Based on how geometry is sketched, automatic relations provide common geometric relationships between objects, such as tangency, parallel, perpendicular, horizontal, and vertical.



Equations • Equations relate dimensions mathematically; they provide an external way to force changes.
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Additional Relations • Other relations added to the model as it is created provide another way to connect related geometry. Some common relations are concentric, coincident, and offset.



Dimensioning • Dimensions of the sketch have an impact on the design intent. Add dimensions in a way that reflects how you would change them and control the elements.
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Parent/Child Relationships (1/6)



Student Notes:



The dependency between one feature and the other is known as a parent/child relationship. Changes to the parent feature can affect the child features, so it is important to create the proper relationships when modeling. Parent/child relationships are an important aspect in maintaining the design intent of the model. There are many ways to create a parent/child relationship, some examples are: Selecting a sketch support Creating the sketcher constraints Projecting 3D geometry in a sketch Selecting certain depth options (like Up to surface, Up to Plane, etc.)
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• • • •
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Parent/Child Relationships (2/6)



Student Notes:



While modeling in CATIA, it is important to understand that the steps to create the model are as important as the end result. You should carefully consider choosing the best base feature, what parent/child relationships should exist, and what dimensions and feature order best reflect the planned design intent. Many design practices are derived from company standards and need to be considered before modeling. Some common design practices are:
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Always choose the most stable feature in the model as the base feature. Try to avoid creating references to dress-up features such as fillets and chamfers. These features may be removed in downstream applications. Choose the best depth option for the application. For example, decide if a pocket is required to cut through the entire model. Creating the pocket with a dimensional depth is not recommended, because the depth of the feature it is cutting through may change; instead, create the pocket with an Up to Last depth.
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Parent/Child Relationships (3/6) 3D reference elements are used mainly to reduce the impact of deletions and optimize designing of parts and their modifications. They are used to ensure consistent parent children relationships.



First case A. B.



C.



B



Create a Base Pad from the sketch shown. Create another sketch on the top face of Base Pad. Constrain the sketch completely using the edges of the Pad. Using this sketch create an Upper Pad. Create a sketch on the top face of Upper Pad. Create a Pocket. Create holes on the top face of the Upper pad. Dimension the holes with respect to the Pad edges.
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D.



A
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C



D
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Parent/Child Relationships (4/6) First case (Continued) E. F. G. H.



E



The upper pad is dependent on the Base Pad. The Pocket is dependent on the Upper Pad. Now when we try to delete the Upper Pad, an update error is displayed. On deletion of Parent feature, the children features are affected.



F



G
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H
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Parent/Child Relationships (5/6) Second case A. B.



C.
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D.



Create a Base Pad from the sketch shown. Create a ‘Sketch’ for ‘Upper Pad’ on the Top reference plane. Dimension the Sketch with reference to standard Planes. Create a ‘Sketch’ for ‘Pocket’ on the top reference plane. Dimension the Sketch with reference to standard Planes. Create ‘Pocket’ using this ‘Sketch’. Create the holes on the top face of the ‘Upper Pad’. Dimension the holes with respect to the standard Planes.



Top Reference Plane



A



B



Bottom Reference Plane



D



C



The sketch for the Upper Pad is independent of the parent Pad. It is created with the help of reference elements
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Parent/Child Relationships (6/6)



The upper Pad Sketch is created on reference Plane and independent on the Base Pad.



Student Notes:



The Pocket Sketch is created on reference Plane and independent on the Upper Pad.



On deletion of the Upper Pad, the pocket is not affected. So parts created using reference



elements are more stable.
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The upper pad is created on Reference elements and is independent of Upper Pad feature.
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CATIA V5 Mechanical Design Expert - Lesson 1: Introduction



Investigating the Model (1/2)



Student Notes:



CATIA has tools available to help you investigate a model. These tools can determine how a model is made, and what parent/child relationships exist. The Specification tree
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As you create features, the specification tree is populated. Use the specification tree to determine how a model is made. For solid modeling, bodies are ordered geometry containers. Features are added to the tree in the order of creation. Therefore children cannot exist in the tree before their parents. For example, the first feature in the specification tree on the right is a pad. Move your curser over the pad in the tree to highlight the pad in the model. The specification tree is also useful when making selections. Rather than highlighting features directly on the model (which can sometimes be difficult), you can use the specification tree.
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Investigating the Model (2/2)



Student Notes:



Model Scan Model scan helps you review the creation of a model, one feature at a time. This tool is helpful to review how models made by others were created. To use the Model scan, click Edit > Scan or Define in Work Object. Parent/Child
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The parent/child tool displays all the parents and children of a selected feature. This tool is useful to determine the relationships that exist in a model. To use the Parent/Child tool, rightclick the feature and click Parent/Children from the contextual menu.



Copyright DASSAULT SYSTEMES



1-22



CATIA V5 Mechanical Design Expert - Lesson 1: Introduction



What is Define in Work Object?



Student Notes:



Parent features must exist in the model tree above any of its children. To create an intermediate feature especially during design modification stage, the define in work object option is used.
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Define in work object is also useful when working with several bodies (in Boolean operations). Using Define in work object you can create features in several bodies. In the example shown, by setting Body.2 as the work object, all new features are created in this body.
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Defining in Work Objects (1/2) Use the following steps to define a work object: 1. Select the feature in the specification tree 2. Right-click the feature and click Define in Work Object from the contextual menu. Notice that all features below the Work object are deactivated.
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1
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2
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Defining in Work Objects (2/2) Use the following steps to define a work object (continued): 3. Create additional features as required. Notice that they are placed directly below the active feature in the specification tree. 4. To re-activate all features in the model, right-click the last feature in the Body and click Define In Work Object from the contextual menu.



Copyright DASSAULT SYSTEMES



3



Copyright DASSAULT SYSTEMES



1-25



CATIA V5 Mechanical Design Expert - Lesson 1: Introduction Student Notes:



Organizing a Solid Model In this section, you will become familiar with the model organizational tools available in CATIA V5.



Use the following steps: 1. 2.



Organizing a Model.
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3.



Review the User Interface. Importance of Parent/Child Relationships
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Model Organization



Student Notes:



As you begin to create complex models, your ability to structure your model properly becomes more important. A properly organized model has the following advantages: • • • •



The model will be easy to interpret by other designers The model will be predictable during modification and update It will be easy to reorder and replace features Problem solving becomes easy as the root cause of the problem can be easily identified.



The following tools are available in CATIA to organize your design
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• Bodies • Geometrical Sets
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Bodies



Student Notes:



Bodies are a storage location for solid features that are added to the part model. By default, all parts contain at least one body the PartBody Additional bodies can be added to provide structure to a complex model. To add a body, click Insert > Body. Each body acts independently in the model until the bodies are combined using Boolean Operations.
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The image on the right-hand side demonstrates a model that was created using multiple bodies. Each body has been renamed according to its function, making it very easy for other designers to interpret the model. The designer can also work on a discrete area of geometry by only displaying the features within a specific body.



Copyright DASSAULT SYSTEMES



1-28



CATIA V5 Mechanical Design Expert - Lesson 1: Introduction Student Notes:



Geometrical Sets Geometrical Sets are a storage location for wireframe and surface features. (Image A). The features in a geometrical set behave in a nonlinear fashion. It is possible to reference a feature that resides in a later position in the tree. Multiple Geometrical Sets can be added to a model in order to organize the wireframe and surface geometry. For example, wireframe and construction geometry could be separated from surface geometry that will be used to create a solid (Image B).



A



C



B
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Geometrical Sets can also be placed within a body. This allows you to group the wireframe and surface geometry and solid geometry within the same body. The body now represents all geometry for a given area of the model providing the designer faster access to the required features (Image C).
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Ordered Geometrical Sets



Student Notes:



An ordered geometrical sets add the functionality of a linear update sequence to the geometrical set. This allows the ordered geometrical set to have the following additional functionalities: • You can scan the features (using Edit > Scan or Define In Work Object) to see the way the features were created • Geometry that is consumed by a downstream feature (e.g. a surface that is trimmed) is not shown. • You can reorder the elements. • New elements inherit their graphical properties from parent elements.
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You can manually add an ordered geometrical set to the model by clicking Insert > Ordered Geometrical Set.
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Hybrid Design (1/2)



Student Notes:



Hybrid Design provides a greater flexibility in structuring your design. The Hybrid Design method uses a special type of Hybrid body that can contain both solid geometry and wireframe and surface geometry without the need to add a geometrical set. When working within the Generative Shape Design (GSD) workbench, wireframe and surface elements will be automatically added to the active hybrid body. You can still add Geometrical Sets, and use their non-linear behavior for processes such as Conceptual Design.
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The combination of Part Design and Generative Shape Design (GSD) functionality allows you to access GSD features from the contextual menu while creating solid features.
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Hybrid Design (2/2)



Student Notes:



The ability to combine wireframe and surface features with the solid feature within the same body allows you to organize these features with respect to their function. For example, the right-hand side image depicts a part model that has been created using hybrid bodies. All the geometrical elements of a specific area of the model have been grouped beneath a hybrid body. This structure shows that the solid features are created after the wireframe and surface features that they reference.
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When the model is interrogated by another designer, the Scan or Define In Work Object function allows the designer to step through the entire design and view the order of creation of both Part Design and GSD features.
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Part Design Recommendations (1/2)



Student Notes:



Since the design of a part corresponds to a set of functional requirements, it is strongly recommended that you organize the structure of your CATIA V5 tree in the same way. Two criteria can be considered for the design intent:
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A. Use reference elements such as parameters and geometrical wireframe and surface as specification inputs.
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Part Design Recommendations (2/2)



Student Notes:
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B. Use functional bodies aggregated with Boolean operations.
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Case Study: Introduction



Student Notes:



Recap Exercise 40 min
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In this exercise you will create a model. The skills needed to create this model were covered in the Fundamentals course. There are no detailed instructions for this exercise. Instead a detailed drawing has been provided for your reference.
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Case Study: Hinge Before you begin to design the model you must analyze what is the best base feature? Which features will make good parent features? Which features will not make good parent features? What is the best orientation of the model? Which reference plane will you choose as the sketch support for the base feature? How will you constraint the base feature? Consider the following: • The Hinge is a molded part that is used in an assembly. • The part is symmetrical. • The holes are centered on the bearings.



Holes Bearings
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Bearing
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Hole
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Do It Yourself: Hinge (1/3)
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Do It Yourself: Hinge (2/3) The following is a suggested method to design the Hinge: Create the base feature. Create the pocket. Create a second pad feature. Create a user pattern. Apply fillets. Apply drafts.
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1. 2. 3. 4. 5. 6.
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3



4



6 5
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Do It Yourself: Hinge (3/3) The following is a suggested method to design the Hinge (continued): 7. 8. 9. 10.



Create second set of fillets Mirror the model. Create hole. Create a user pattern.



7 8 9
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Case Study: Hinge Recap



Student Notes:
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Determine the best base feature. Determine the best orientation. Determine which parent/child relationships should be created and which should be avoided. Determine the best way to organize the model.
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To Sum Up



Student Notes:
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In the following slides you will find a summary of the topics covered in this lesson.
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Review the User Interface



Student Notes:



Copyright DASSAULT SYSTEMES



CATIA is mechanical design software. It is a feature-based, parametric solid modeling design tool that takes advantage of the easy-to-learn Windows graphical user interface. You can create fully associative 3D solid models with or without constraints while utilizing automatic or user-defined relations to capture design intent. The Part Design workbench lets you build solid 3D geometry. From the Part Design workbench you can access the Sketcher workbench and create 2D profiles that will become 3D model. The Assembly Design workbench allows you to bring components together to create the final product. You can design parts in the assembly context and use methods of designing assemblies that will aid in concurrent engineering, such as Skeleton models and publishing elements. The Generative Shape Design workbench lets you create surface and wireframe geometry. The surface and wireframe geometry allows you to create more complex solid models and gives more control over the shape of a model.
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Importance of Parent/Child Relationships (1/2) Design intent is a plan to construct solid model of a part, in order to convey its visual and functional aspects. The way a solid model is built can affect many aspects, including its flexibility to changes, its stability during the change process, and the resource requirements to compute a new result. Therefore, it is important to take the design intent into account to achieve an efficient solid model of the part.



Top Reference Plane 1



2 Bottom Reference Plane



3 4
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The dependency between one feature and the other is known as a parent/child relationship. Parent/Child Relationships are important in maintaining the design intent of the part. You should carefully consider choosing the best base feature, which parent/child relationships should exist, and what dimensions and feature order best reflect the planned design intent.
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Importance of Parent/Child Relationships (2/2) Many design practices are derived from company standards and need to be considered before modeling. Some common design practices are: The upper Pad Sketch is created on reference Plane and independent on the Base Pad.



The Pocket Sketch is created on reference Plane and independent on the Upper Pad.



On deletion of the Upper Pad, the pocket is not affected.
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Always choose the most stable feature in the model as the base feature. Try to avoid creating references to dress-up features such as fillets and chamfers. These features may be removed in downstream applications. Choose the best depth option for the application. For example, decide if a pocket is required to cut through the entire model. Creating the pocket with a dimensional depth is not recommended, because the depth of the feature it is cutting through may change; instead, create the pocket with an Up to Last depth.
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Main Tools / Menus (1/2) Investigating the Model 1



Scan or Define In Work Object: Helps you review how the model was created, feature by feature.



2



Parent/Children: Displays the parent and children of the selected feature and hence helps to display the relationships that exist in the model. Define in Work Object: Activates the current selected feature disabling all child features. You can use Define in Work Object to review the feature, edit it or modify the design.



3



1
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Lesson 1: Introduction to Generative Shape Design ... 'CATIA V5 for Surfaces' is to teach you how to build basic and advanced ... This course is designed using a process-based approach to training. ... You should view the student manual as a suppleme










 








CATIA V5 Surface Design - MAFIADOC.COM 

In complex models, features must be structured in a logical way. It helps in better understanding of the designing process and reduction in tree size. Structuring ...










 








CATIA V5 Surface Design .fr 

Aug 19, 2008 - Users familiar with CATIA V5 Fundamentals ... which you would use particular tools and methods, and illustrate the process flow to be followed for a project. ... Example page: .... assembly. ..... Select Part Arm Rest as Father. d.










 








Structure Design CATIA V5 Training 

Jan 19, 2009 - Switch to Assembly Design workbench. Create coincidence constraint between published support face from Panel_P11 and Extract.1 line from ...










 








CATIA Product Design Expert .fr 

Sep 19, 2008 - The bottom face of the insert contextually rests ...... When creating an assembly hole, you will create a sketch that will belong to the part.










 








Structure Design Administration CATIA V5 Training .fr 

Jan 19, 2009 - ... 7: Creating a Slot. 65. Step 8: Creating a Small Assembly (T-Chock) ... Modify the aliases as follow (depending on where CATIA is installed) ...










 








Part Design Features Recognition CATIA V5 Training 

Jan 19, 2009 - Students attending this course should have knowledge of CATIA V5. Fundamentals .... shaft, groove), as well as dress-up features (fillet and ...










 








Mold Tooling Design CATIA V5 Training 

Jan 19, 2009 - EXERCISE BOOK ... Master Exercise (2): Creating Mold Components. 8. Do It Yourself. 9. Master Exercise (3): Creating Injection Features. 10.










 








Part Design Features Recognition CATIA V5 Training 

Jan 19, 2009 - Performing Manual Feature Recognition. 15 .... Manual FR allows to recognize a large range of feature ... Fillet (rolling ball, constant radius).










 








V5 Administration CATIA V5 Training 

Sep 19, 2008 - -admin: Starts CATIA in administrator mode for the purpose of locking settings. -object: Starts CATIA and loads the specified object. Windows ...










 








ASSEMBLAGE sous CATIA V5 

ASSEMBLAGE sous CATIA V5. 1. L.LEVREL. Assemblage sous catia V5 R14.doc. DÃ©marrer -> Conception mÃ©canique -> Assembly Design pour lancer l'atelier.Missing:










 








CATIA V5 Analysis 

Jan 19, 2009 - parts and assemblies designed in CATIA. This course focuses .... and post-process the part or assembly in the case study. Each step contains ...










 








CATIA V5 Fundamentals - MAFIADOC.COM 

Each case study contains a set of model requirements, known as the design intent. The first case study does not contain a design intent because you are not ...Missing:










 








CATIA V5 Fundamentals 

Aug 19, 2008 - August 2008 .... Individual case studies are used as building blocks towards the completion of a final .... CATIA V5 is specifically designed for the Windows operating environment, and ..... The documentation may also be installed on a










 








CATIA V5 Surfaces 

Aug 19, 2008 - To create spline or a polyline, you only need points. And to create a circle, you only .... Important: the curve is deformed and you control the maximum deviation ...... And stress the fact that it requires a lot of work. This is far f










 








CATIA V5 Analysis 

photocopying, recording or otherwise, without the express prior written permission of DASSAULT SYSTEMES. This courseware may only be used with explicit.










 








CATIA V5 Automation 

Jan 19, 2009 - Macros Options Interface. 34 ..... This kind of applications can be developed in: ..... It is possible to develop an application in Visual Basic, then.
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